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Uvod 

 

U ovom radu je opisan eksperiment telemetrijske stanice u poljoprivredi, koja mjeri temperaturu, 

vlažnost vazduha i vlažnost zemljišta, te podatke šalje serveru IoT tima, kakav je ThingsSpeak, kako bi 

se mogli pogledati na bilo kom mjestu putem interneta i povratno reagovati. Primopredajnik čine 

dva mikrokontrolera WiFi LoRa 32(V2), proizvođača Heltec, koji su opremljeni protokolom za 

komunikaciju LoRa. Radi se o radijskom frekvencijsko modulisanom signalu male potrošnje, posebno 

namijenjenom IoT uređajima. 

Prvi uređaj radi kao prijamnik-posrednik, u dometu je WiFi mreže i povezan je sa ThingSpeak 

serverom. On je posrednik u komunikaciji servera sa drugim uređajem putem LoRa mreže, koji se 

nalazi dalje izvan dometa WiFi signala. Na svom ekranu prikazuje informacije od značaja. 

Drugi uređaj (stanica) se sastoji od: mikrokontrolera WiFi Lora 32(V2) sa senzorom vlažnosti i 

temperature DHT11, senzorom vlažnosti zemljišta domaće proizvodnje, solarne ploče, akumulatora i 

elektronskog kola za regulaciju napajanja. 

Mikrokontroleri su programirani u razvojnom okruženju Arduino IDE, za koje postoje zvanično 

podržane biblioteke od strane proizvođača. 

Stanica šalje podatke prikupljene od senzora prvom uređaju putem protokola LoRa; dok on 

podatke prosljeđuje serveru putem WiFi mreže. Omogućena je i povratna komunikacija na zahtjev 

servera, tako što stanica prima kontrolne vrijednosti koje se zadaju na serveru, i u skladu sa tim 

pokreće ili obustavlja odgovarajuće radnje (npr. upravljanje sistemom za navodnjavanje ili 

održavanje vlažnosti i temperature). Kao rezultat su dati grafički prikazi promjene temperature i 

vlažnosti, što korisnicima može dati bolji uvid u stanje na poljoprivrednom imanju i, u skladu s tim, 

biljke mogu dobiti odgovarajući tretman. 

Prvo poglavlje opisuje fizičko-funkcionalne cjeline sistema. U drugom poglavlju su opisane 

tehničke karakteristike korišćenih uređaja i opreme, s posebnim osvrtom na sistem za napajanje i 

softversku pripremu rada sa mikrokontrolerom. U trećem poglavlju su dati osnovni podaci o 

protokolu LoRa, čije su osobine značajne za ovaj projekat. U četvrtom poglavlju je opisana 

internetska platforma ThingSpeak koja je zaslužna za daljinsko pregledanje i upravljanje. Peto 

poglavlje sadrži podatke o načinu rada kapacitivnih senzora, dok je u šestom opisan korišćeni 

postupak kalibracije. Sedmo poglavlje sadrži opis i uputstvo izrade štampanih ploča UV metodom, 

kojim je proizvedena ploča za kapacitivni senzor. U posljednjem, osmom poglavlju, prikazani su 

rezultati mjerenja u vidu grafika i tabela. 
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I Osnovne cjeline sistema  
 

Sistem se može podijeliti na više funkcionalnih cjelina koje su međusobno povezane u jedan 

složeni sistem, kao što je prikazano na slici 1.1. Senzori prikupljaju podatke od značaja kao što su: 

temperatura, vlažnost vazduha, vlažnost tla, intenzitet svetlosti itd. i šalju ih na STANICU koja se 

sastoji od: nodeMCU (moderni umreženi mikroprocesor), LoRaWAN komunikacionog modula, 

aktuatora i prednjeg kraja senzora, napajanja zasnovanog na autonomnom sistemu solarnih baterija 

i izlaznom (prekidaču) modulu. Prethodno obrađeni podaci su poslati putem LoRaWAN-a 

DALJINSKOM KOLEKTORU, koji dalje putem WiFi-ja i rutera (hot spot) komunicira sa CLOUD-om, na 

kojem su integrisane komercijalne IoT platforme poput ThingSpeak, IFTTT. Kao rezultat, izmjerene 

veličine se mogu pratiti putem interneta bilo gdje i bilo kada, analizirati i povratno reagovati. 

 

Slika 1.1: Funkcionalne cjeline sistema 

 

Principijelna šema stanice je data na slici 1.2. 
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Slika 1.2: Principijelna šema 

 

Ono što se na prvi pogled vidi jesu dva uređaja između kojih se održava bežična komunikacija 

putem mreže LoRaWAN. Desno je prikazan manji, priručni, uređaj čiji su glavni zadaci veza sa 

serverom i prikazivanje trenutnih rezultata mjerenja. Njegov softver vodi računa o protokolu za 

komunikaciju i o sinhronizaciji. 

Uređaj prikazan lijevo predstavlja stanicu koja se nalazi napolju. Ima isti softverski dio, i razlikuje 

se po hardverskj implementaciji. Neophodno je bilo obezbijediti napajanje, što je urađeno pomoću 

punjivog akumulatora i solrnog izvora energije; tako da može da radi samostalno tokom dužeg 

vremena. Kontrolna elektronika je zadužena da taj dio radi ispravno, što je detaljnije opisano u 

poglavlju 2.2.1. 

Senzori ostvaruju vezu sa spoljašnjim svijetom, i ovdje su upotrijebljena dva senzora koja mjere tri 

fizičke veličine. Pošto mikrokontroler ima osamnaest analogno-digitalnih konvertora, moguće je 

priključiti najviše isto toliko senzora. Na slici 1.2 je prikazan fizički izgled pojedinačnih djelova 

sistema. 
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Slika 1.2: Stanica u vinogradu (lijevo), priručni uređaj (desno) i unutrašnjost kutije na stanici (ispod) 
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II Tehničke karakteristike 

 

2.1 Heltec WiFi LoRa 32(V2) 

Pokreće ga dvojezgarni procesor ESP32 sa taktom od 240 MHz (Tensilica LX6 dual-core). 

Opremljen je: WiFi, Bluetooth i LoRa standardima za bežičnu komunikaciju, sa gornjom granicom 

izlazne snage od 19dB za komunikaciju putem protokola LoRa, sa naznačenim dometom od 5km. 

Mikrokontroler posjeduje tri UART kola (universal asynchronous receiver-transmitter) za serijsku 

komunikaciju, po dva SPI (serial peripheral interface) i I2C (inter-integrated circuit), I2S (inter-ic 

sound); osamnaest dvanaestobitnih ADC ulaza i dva osmobitna DAC izlaza, 22 GPIO (general-purpose 

input/output) i šest GPI pinova. Raspored pinova je prikazan na slici 2.1. 

Ima 8MB SPI Flash memorije i 520KB interne SRAM memorije; jedan mikro USB priključak, IPEX 

priključak za antenu i ukupno 36 pinova za povezivanje sa spoljašnjim uređajima. Ima i ugrađeni 

OLED displej veličine 0,96 inča. 

Potrošnja struje u režimu deep sleep iznosi 800µA, dok se radna temperatura kreće u opsegu od -

40 do 80 °C. 

Slika 2.1: Dijagram pinova 

Po karakteristikama značajno nadmašuje popularne mikrokontrolere Arduino, što ga čini 

pogodnim za zahtjevnije primjene gdje je potrebno voditi računa o većem broju zadataka. 
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2.2 Izvori napajanja 

U projektu je korišćen olovni akumulator proizvođača Ultracell – UL 4-12 (12V 4AH/20HR) i 

solarna ploča snage 5W koja na sunčevoj svjetlosti daje napon od oko 20V. 

 

2.2.1 Električna šema sistema napajanja 
 

Sistem se kontroliše pomoću dva prekidača – P1 i P2 (slika 2.2). Prekidač P1 uključuje akumulator 

u kolo, čime je omogućeno i njegovo punjenje. Prekidač P2 upravlja radom regulatora napona L7805, 

što određuje da li će na njegovom izlazu biti napona. Regulator LM7805 na izlazu daje konstantni 

napon od 5V i struju 1,5A za vrijednost ulaznog napona od 7-25V, pa je zato savršen za rad za 

mikrokontrolerima. 

Drugi regulator napona koji je korišćen je LM317, i on služi za spuštanje napona solarne ploče na 

prihvatljivi nivo za punjenje akumulatora. U stanju je da na izlazu da napon od 1,25-37V i struju veću 

od 1.5A, a podešava se pomoću samo dva otpornika – u ovom slučaju otpornikom R2 i 

potenciometrom R1. Podešen je tako da daje napon od 13V, koji bi nakon slabljenja na Cenerovoj 

diodi D1 od oko 0,4V nadjačao napon na akumulatoru i tako započeo njegovo punjenje, ujedno 

napajajući regulator L7805. 

 

Slika 2.2: Električna šema sistema za napajanje 

 



Telemetrijska IoT stanica za potrebe precizne poljoprivrede Specijalistički rad 
 

12 
 

Dioda D2 spušta napon ka bazi za 8V. Da bi tranzistor T proveo, pad napona na otporniku R4 ne 

smije da bude veći od 4V, što odgovara struji baze od 4mA. Struja Iadj može da se kreće u opsegu od 

50-100μA, dok je napon na otporniku R2 (između priključaka ADJ i VO) konstantan i iznosi 1,25V 

(dato je u specifikacijama regulatora), što osigurava da napon na kolektoru bude uvijek veći od 

napona na bazi (i u ovom slučaju jednak 11,75V). To znači da tranzistor radi u direktnom aktivnom 

režimu (Vc > Vb > Ve). U tom slučaju možemo zanemariti struju kroz granu u kojoj se nalazi baza 

tranzistora, zbog čega se jasnije vidi da je njegova uloga odvođenje viška izlazne struje na masu, kako 

bi se akumulator punio sporije i tako duže trajao. 

 

2.3 Korišćeni senzori 

Posljednje vrijeme karakteriše sve veća popularnost i pristupačnost mikrokontrolerske 

elektronike, koja lako nalazi put do: amatera, studenata, pa i profesionalaca. Velikim izborom 

mikrokontrolera (Arduino, ESP32, Raspberry Pi...) je obuhvaćen široki spektar različitih primjena. 

Tako se mogu naći najrazličitiji senzori i periferije po niskim cijenama. Od komercijalnih rješenja je u 

ovom radu korišćen senzor DHT11 koji mjeri temperaturu i vlažnost vazduha. Senzor vlažnosti 

zemljišta će biti detaljnije opisan u poglavlju 5 jer predstavlja originalno rješenje, nastalo tokom 

razvoja ovog rada. 

Senzor DHT11 spada u digitalnu vrstu senzora. Sadrži kapacitivni senzor vlažnosti i termistor za 

mjerenje okolnog vazduha, i prenosi digitalne podatke putem za to namijenjene nožice (pina). On 

može da se napaja naponom u opsegu od 3-5V, što podržavaju svi poznatiji mikrokontroleri. Opseg 

mjerenja temperature iznosi od 0-50 °C uz tačnost od ±2°C, a opseg vlažnosti iznosi 20-80% pri 

tačnosti od 5%. Podaci se na njemu mogu očitati u razmaku od najmanje dvije sekunde, a njegova 

veličina iznosi 15,5 x 12 x 5,5 mm. Dolazi u kućištu sa tri ili četiri kontakta – od kojih se tri koriste, I to 

dva za napajanje i jedan za prenos podataka. Nešto bolji po pitanju performansi je njegov nasljednik 

– DHT22, koji je i skuplji. Na slici 2.3 je prikazan senzor  DHT11 na eksperimentalnoj ploči. 

 

 

Slika 2.3: Senzor DHT11 
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2.4 Arduino IDE 

Najprije je potrebno instalirati razvojno okruženje Arduino IDE (engl. Integrated Development 

Environment – integrisano razvojno okruženje) za odgovarajući operativni sistem, prateći uputstvo sa 

zvaničnog sajta: https://www.arduino.cc/en/software. Softver je besplatan, uz mogućnost doniranja 

proizvođaču. Instalacija je jednostavna i čista, i ne sadrži reklamiranje dodatnog softvera. 

Slika 2.4: Pristupanje podešavanjima 

 

Da bi mikrokontroler LoRa 32(V2) mogao da se programira u razvojnom okruženju Arduino, 

potrebno je instalirati ploču unutar upravljača pločama (Arduino Boards Manager). On se nalazi u 

meniju File > Preferences (slika 2.4). Zatim u polju Additional Boards Manager URLs (Slika 2.5) treba 

unijeti sledeću adresu: https://resource.heltec.cn/download/package_heltec_esp32_index.json. 

Slika 2.5: Unošenje adrese za odgovarajuću ploču 

 

https://www.arduino.cc/en/software
https://resource.heltec.cn/download/package_heltec_esp32_index.json
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Nakon toga se može instalirati ploča Heltec ESP32, pritiskom na Tools > Board > Boards Manager 

(Slike 2.5 i 2.7). U polju za pretragu unijeti Heltec ESP32, i pritiskom na dugme Install započinje 

instalacija koja može potrajati nekoliko minuta. 

Slika 2.6: Pristupanje upravljaču pločama 

Slika 2.7: Upravljač pločama 

 

Naredni korak je instaliranje biblioteke Heltec ESP32. Odabirom Sketch > Include Library > 

Manage Libraries, dolazi se do upravljača bibliotekama (Library Manager) – Slika 2.8, koji je sličan 

upravljaču pločama (Boards Manager). Unosom Heltec ESP32 u polju za pretragu, filtriraće se 

biblioteka Heltec ESP32 Dev-Boards by Heltec Automation. Pritiskom na dugme Install, biće 

instalirana vrlo brzo. 
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Slika 2.8: Upravljač bibliotekama 

 

Kada je i to uspješno završeno, ploča LoRa 32(V2) se može programirati kao i bilo koja Arduino 

ploča, odabirom na Tools > Board > WiFi LoRa 32(V2) i odgovarajućeg porta, što je dato na slici 2.9. 

Razlika je jedino u rasporedu i namjeni pinova i funkcionalnosti koje karakterišu svaku ploču, pa 

programski kod treba prilagoditi datim uslovima i mogućnostima samog mikrokontrolera. 
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Slika 2.9: Odabir ploče WiFi LoRa 32(V2) 

 

Uputstvo je pisano za verziju razvojnog okruženja Arduino 1.8.13, dok kod drugih verzija može 

doći do neznatnih odstupanja u rasporedu komandi u grafičko-korisničkom interfejsu. 

 

III Protokol LoRaWAN 
 

3.1 Osnovni podaci 

LoRaWAN je WAN protokol male snage (Low Power Wide Area Networking), osmišljen sa ciljem 

bežičnog povezivanja na internet uređaja sa baterijskim izvorom napajanja, i cilja glavne zahtjeve 

Internet of Things (IoT), kao što su: dvosmjerna komunikacija, bezbjednost prenosa podataka, 

mobilnost i usluge lokalizacije. 

Iza njega stoji neprofitno udruženje otvorenog tipa LoRa Alliance, koje je počelo sa radom u 

martu 2015. godine. 

LoRa je fizički sloj bežične modulacije koji se koristi za stvaranje posrednika za komunikaciju 

velikog opsega. Mnogi prevaziđeni bežični sistemi koji su u širokoj upotrebi koriste frekvencijsku 

modulaciju (frequency shift keying – FSK) kao fizički nivo, jer je ona veoma pogodna za malu 

potrošnju. LoRa je zasnovan na “cvrkutnoj” sprektralnoj modulaciji (chirp spread spectrum 

modulation – CSS), koja ima iste karakteristike male snage kao i FSK modulacija, dok značajno 

povećava domet komunikacije. CSS se već decenijama koristi u vojnoj i svemirskoj komunikaciji zbog 

velike daljine koja se postiže i otpornosti na smetnje, a LoRa je prva jeftina implementacija 

namijenjena komercijalnoj upotrebi. 
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Slika 3.1: Prikaz chirp-a u vremenskom (lijevo) i frekventnom (desno) domenu; primjer kodirane poruke. 

Preuzeto iz literature [11] 

 

Kao što se vidi u frekvencijskoj analizi datoj na slici 3.1, ključni parametri ovog signala su: početna 

i krajnja učestanost i brzina njene promjene. 

Ključne odlike tehnologjie LPWAN (low-power wide-area network) su: 

• Arhitektura mreže 

• Komunikacioni opseg 

• Trajanje baterije ili mala potrošnja 

• Otpornost na smetnje 

• Kapacitet mreže (najveći broj čvorova unutar mreže) 

• Bezbjednost mreže 

• Jednosmjerna i dvosmjerna komunikacija 

• Raznovrsnost primjena u kojima se upotrebljuje 

 

3.2 Sigurnost komunikacije 

LoRaWan posjeduje dva sloja bezbjednosti: na nivou mreže i na nivou aplikacije. Mrežna 

bezbjednost garantuje autentičnost čvora u mreži, dok aplikativni sloj bezbjednosti osigurava da 

operator mreže nema pristup aplikativnim podacima krajnjeg korisnika. Koristi se metod kriptovanja 

AES uz razmjenu ključa pomoću identifikatora IEEE EUI64. 

3.3 Realizacija u projektu 

Kako je sistem zamišljen tako da se jedan uređaj nalazi u polju nepokriven WiFi signalom, dok 

drugi posreduje u komunikaciji sa serverom – zbog zadavanja komandi putem servera koje se 
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izvršavaju na uređaju u polju, potrebno je bilo realizovati dupleks sistem komunikacije. Dakle, 

između uređaja postoji dvosmjerna komunikacija protokolom LoRa. 

Što se tiče programskog rješenja, postoje dvije mogućnosti: bez blokiranja i sa blokiranjem 

(callback). U prvom slučaju se neprekidno osluškuje moguća dolazeća poruka, čak i tokom slanja, pa 

je ostvariva istovremena dvosmjerna komunikacija. U drugom slučaju se ne osluškuje dolazna poruka 

dok se odašilje, pa je u ovom projektu korišćen metod bez blokiranja. Za oba postupka se mogu naći 

gotovi primjeri: File > Examples > LoRa, zatim: LoRaDuplex ili LoRaDuplexCallback. 

Iako je u istovremena dvosmjerna komunikacija moguća, zbog zauzetosti procesora drugim 

zadacima (mjerenja, kombinovanje poruke, kontrola, veza sa serverom, itd…), bilo je potrebno 

povesti računa o sinhronizaciji slanja i primanja poruka, kako bi uspješnost prijema bila što veća.  

 

IV ThingSpeak 

ThingSpeak je IoT analitička platforma koja omogućava: sakupljanje, vizualizaciju i analiziranje 

strimova podataka na cloud-u. Podržan je MATLAB kod za obradu podataka na serveru. ThingSpeak 

može koristiti inženjerima i naučnicima za prototipovanje i izgradnju IoT sistema bez postavljanja 

servera i razvijanja web softvera. 

Podaci koje prikuplja senzor se mogu slati ThingSpeak serveru direktno sa mikrokontrolera koji 

podržava: TCP/IP, HTTP ili MQTT protokol. 

 

4.1 Sistem sa povratnom spregom 

Na kanalu ThingSpeak se nalaze tri grafika koja prikazuju mjerene veličine u realnom vremenu, 

tako da se mogu pratiti i analizirati nastale promjene. Četvrti grafik je takođe pokaznog karaktera, i 

on služi za prikazivanje kontrolnih stanja, tj. uređaja koji bi se uključivali i isključivali na osnovu 

razlike između zadatih i izmjerenih vrijednosti. Grafici su dati na slici 4.1. 

Za zadavanje vrijednosti se koristi polje Send Command, gdje se zadaje string u obliku A:BC, gdje 

A predstavlja broj kanala kome je namijenjena komanda, dok je BC brojna vrijednost kojom se 

poredi. Na primjer, ako trenutna temperatura (drugi kanal) iznosi 23°C, a zadata je komanda 2:30 – 

tada bi se uključio potencijalni sistem za grijanje dok temperatura ne bi dostigla 30°C, a u kontroli 

bismo vidjeli broj 2 (010). 
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Mikrokontroler koji održava vezu sa WiFi mrežom redovno provjerava server na nove zadate 

poruke, koje prosljeđuje putem LoRa mreže drugom mikrokontroleru. Na njemu se vrši upoređivanje 

vrijednosti i, sljedstveno tome, paljenje ili gašenje odgovarajućih uređaja – u ovom slučaju prostih 

LED dioda radi pokazivanja (slika 4.2). Zatim se promijeni i odgovarajući kontrolni bit i pošalje nazad 

prvom mikrokontroleru, koji ažurira ThingSpeak server. Na ovaj način je postignuta napredna 

funkcionalnost i fleksibilnost sistema, što je kod savremenih kućnih i industrijskih IoT uređaja 

obavezna stavka. 

Slika: 4.1: Dijagrami na kanalu ThingSpeak koji predstavljaju: vlažnost vazduha, temperaturu vazduha, 

vlažnost zemljišta i kontrolni broj 

 

Slika 4.2: Vizualizacija upravljačkih signala na stanici – jedan od potencijalnih uređaja bi bio pušten u pogon 
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4.2 Filtriranje podataka 

S obzirom na to da su sve poruke dvostruko šifrovane AES kriptografskim algoritmima, ukoliko 

dođe do greške u komunikaciji – pristigla poruka će biti neprepoznatljivo različita od one 

namijenjene (npr. umjesto čitljivog teksta se pojavljuju nasumični znaci). Što je veća udaljenost 

između uređaja – veća je i vjerovatnoća pogrešnog prijema, do čega uvijek i dođe nakon izvjesnog 

vremena. Kako je paket koji se šalje u ovom projektu binarni, kombinujući više brojnih vrijednosti u 

jedan binarni niz, to bi ThingSpeak server na pogrešnu (haotičnu) poruku reagovao upisivanjem nule 

ili neke nasumične vrijednosti, što je prikazano na slici 4.3. 

Slika 4.3: Odstupanje od stvarnih vrijednosti usljed greške u komunikaciji 

 

Pošto je ovakva promjena očitavanja fizički malo vjerovatna, i, u suštini, netačna, potrebno je 

filtrirati brojne vrijednosti u skladu sa očekivanim. Na primjer, ne očekuju se nagli pojedinačni 

skokovi ili izlazak iz opsega vrijednosti koje bilježi senzor. Filtar je moguće podesiti na serveru, 

koristeći Matlab, ili na samom mikrokontroleru koji komunicira sa serverom. U ovom projektu je 

izvršena provjera ispravnog prijema poruke kod mikrokontrolera. Ako se sve brojne vrijednosti 

nalaze u očekivanom opsegu, poruka je označena kao ispravna i može se poslati na server i pamti se 

u lokalnoj promjenjivoj. Ukoliko nije, umjesto nje će se poslati poslednja ispravno primljena poruka, 

koja je prethodno zapamćena. Ako se, umjesto toga, slanje poruke na server preskoči, dvije susjedne 

tačke na grafiku bi se povezale linijom, sa odgovarajućom vremenskom razlikom. 

V Senzor vlažnosti zemljišta 
 

Za potrebe ovog rada, razmatrano je više pristupa i komercijalnih rješenja za mjerenje procenta 

vlažnosti zemljišta. U elektro struci se ono zasniva na jednom od dva principa: provodnom i 

kapacitivnom. Zbog brojnih prednosti je izabran kapacitivni senzor, a njegova pločica je štampana UV 

metodom. 
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5.1 Provodni sistem 

Kod ovog sistema između elektroda protiče električna struja, čiji je intenzitet direktno srazmjeran 

količini vode koja se nalazi u zemlji. Problem se svodi na mjerenje otpornosti između elektroda, što 

je u principu najjednostavnije rješenje. Međutim, velika mana ovakvog sistema jeste osjetljivost na 

koroziju – upravo zbog izlaganja metalnih djelova vlazi i hemijskim dodacima u zemljištu. Vremenom 

su očitavanja sve nepouzdanija, dok, posle izvjesnog vremena i istrošenosti elektroda, senzor postaje 

neupotrebljiv. Ilustracija i princip rada su dati na slici 5.1. 

Slika 5.1: Postupak mjerenja vlažnosti zemljišta provodnim sistemom 

 

Rezultat mjerenja se dobija mjerenjem pada napona na ekvivalentnom otporniku Rz. Ako je 

poznat napon V1, tada se na osnovu mjerenja napona V2 rezultat računa po jednačini 5.1. 

𝑉𝑙 =
𝑉2

𝑉1
∙ 100 [%] 

Jednačina 5.1: Računanje procenta vlažnosti na osnovu početnog i izmjerenog napona 

Na primjer, ako nema prisustva vode u zemlji – tada neće proticati struja i, što predstavlja prekid 

na otporniku Rz, pa će napon V2 biti jednak nuli. Tada je i rezultat jednačine 0%, što je u skladu sa 

polaznom pretpostavkom. 
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5.2 Kapacitivni sistem 

Kapacitivni sistem se zasniva na razlici između dielektričnih konstanti vode i zemlje. Relativna 

dielektrična permitivnost suvih zemljišta iznosi između 2 i 6, dok je njena vrijednost kod vode ugrubo 

oko 80 (mijenja se u zavisnosti od temperature). Između kapacitivnosti i dielektrične konstante važi 

linearna zavisnost. 

Elektrode kod kapacitivnog sistema su električno izolovane tako da obrazuju jedan kondenzator. 

Drugi, njemu paralelno vezani kondenzator, obrazuje se sa zemljom. Prisustvo vode u zemlji utiče na 

njegovu kapacitivnost, što uzrokuje da ekvivalentna kapacitivnost zavisi od količine vode. Problem 

vlažnosti zemljišta se sada svodi na mjerenje kapacitivnosti, što je dosta izazovno s obzirom na njenu 

malu veličinu (reda pF). Ovakvim sistemom se dobijaju pouzdana i precizna mjerenja, bez pojave 

korozije čak i nakon dužeg vremena korišćenja. Može se lako prilagoditi i korišćenju u druge svrhe, 

na primjer kao detektor metala. 

U ovom primjeru je kapacitivnost iskorišćena za diktiranje trajanja impulsa kod impulsno-širinske 

modulacije (PWM). Njih generiše Šmitovo okidno kolo pri učestanosti od preko 150 kHz, a zatim se 

dovode na filtar i pojačavač. Kao rezultat svih ovih operacija, mjerena veličina je predstavljena 

naponom koji se jednostavno može izmjeriti. 

Slika 5.2: Postupak mjerenja vlažnosti zemljišta kapacitivnim sistemom 

 

Sonda senzora se sastoji od dvije izolovane elektrode, koje obrazuju kondenzator kapacitivnosti 

C1. Svaka od ovih elektroda ima i parazitivnu kapacitivnost prema provodnim predmetima u svojoj 

okolini. Upravo ta parazitivna kapacitivnost nam je od koristi u ovom postupku. Kada su elektrode 

uronjene u zemlju, obrazovaće se kondenzatori kapacitivnosti C2 i C3 između elektroda i zemlje. Oni 

su vezani redno, pa se mogu predstaviti ekvivalentnom kapacitivnošću C23, što je dato u jednačini 

5.2. 
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𝐶23 =
𝐶2 ∗ 𝐶3

𝐶2 + 𝐶3
 

Jednačina 5.2: Redna veza kapacitivnosti 

Sada je sa slike jasno da su kondenzatori C1 I C23 vezani paralelno, pa će biti: 

𝐶𝑒 = 𝐶1 + 𝐶23 = 𝐶1 +
𝐶2 ∗ 𝐶3

𝐶2 + 𝐶3
 

Jednačina 5.3: Ekvivalentna kapacitivnost 

Posmatrano u teoriji, dodatne parazitne kapacitivnosti se javljaju između elektroda i svih 

provodnih tijela u bližoj i daljoj okolini; ali njihov značaj se može zanemariti s obzirom da njihova 

vrijednost opada srazmjerno rastojanju, pa se mogu uzeti samo najbliži činioci – u ovom slučaju voda 

u zemlji. U praksi se ovo pokazuje opravdano, s obzirom na stalnost dobijenih rezultata (kretanje 

provodnih tijela u nešto daljoj okolini bi dodatno uticalo na ekvivalentnu kapacitivnost, što bi dovelo 

do promjene rezultata). Značajna razdaljina za mjerenje iznosi par centimetara, što je otprilike i 

najmanji razmak između sonde senzora i zidova posude sa zemljom potreban za tačno mjerenje. 

 

5.3 Princip rada razvijenog kapacitivnog senzora 

Princip rada senzora je dat na slici 5.3. U suštini predstavlja pretvarač razlike kapacitivnosti Cx i 

Cref u PWM signal. Oscilator frekvencije f pogoni dvije paralelne grane RCref i RCx gdje je Cx 

kapacitivnost izmedju elektroda senzora, dok je Cref referentna kapacitivnost koja je u slučaju 

stacionarnog stanja, odsustva zemljišta, približno jednaka Cref. RC kola izazivaju određeno kašnjenje. 

Razlika kašnjenja DELAY(RCx)-DELAY(RCref) je faktički jednaka 0, ako je Cx=Cref.  Što je Cx veće, veće 

je i kašnjenje, T2>T1. Tj. mijenja se faktor popunjenosti: 

𝐷 =
𝑇𝑜𝑛

𝑇𝑜𝑛 + 𝑇𝑜𝑓𝑓
 

Jednačina 5.4: Računanje faktora popunjenosti 

da bi se u krajnjem slučaju dobila formula: 

𝑦̅ =
1

𝑇
∫ 𝑓(𝑡)𝑑𝑡

𝑇

0

 

𝑦̅ =
1

𝑇
(∫ 𝑦𝑚𝑎𝑥𝑑𝑡 + ∫ 𝑦𝑚𝑖𝑛𝑑𝑡

𝑇

𝐷𝑇

𝐷𝑇

0

) 

=
1

𝑇
(𝐷 ∙ 𝑇 ∙ 𝑦𝑚𝑎𝑥 + 𝑇(1 − 𝐷)𝑦𝑚𝑖𝑛) 

= 𝐷 ∙ 𝑦𝑚𝑎𝑥 + (1 − 𝐷)𝑦𝑚𝑖𝑛 

tj. 
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𝑉𝑎𝑣𝑒 = 𝐷 ∗ 5𝑉 + (1 − 𝐷) ∗ 0𝑉 = 𝐷 ∗ 5𝑉 

𝑉1 = 𝑇1 ∗ 𝑓 ∗ 5𝑉 

𝑉2 = 𝑇2 ∗ 𝑓 ∗ 5𝑉 

Jednačina 5.5: Računanje srednje vrijednosti napona 

Pošto je T>T2, jasno je da je V2>V1, tj. napon na izlazu kola je proporcionalan kapacitivnosti Cx po 

određenoj zakonitosti. Treba napomenuti da filter propusnik niskih učestanosti (LOW-PASS FILTER) 

pegla invertovani napon VD I tako čini PWM filter. Slika 5.4 predstavlja simulaciju sistema u LT Spice-

u koja se odlično poklapa sa fizički mjerenim vrijednostima pomoću osciloskopa. 

Slika 5.3: Principijelna šema senzora 

 

Slika 5.4: Vremenski dijagrami u karakterističnim tačkama dobijeni simulacijom 
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VI Kalibrisanje senzora 

 

Vrijednost napona, koja je dobijena gore opisanim postupkom, potrebno je pretvoriti u jedinicu 

mjere – procenat sadržaja vode u supstanci. Najjednostavniji način za to je pomoću već kalibrisanog 

senzora (etalona), mapiranjem brojnih vrijednosti ili pronalaženjem aproksimativne krive vlažnosti. 

Drugi način je eksperimentalno utvrđivanje vodene mase u uzorku zemljišta. Mjerenjem ukupne 

mase vode se računa njen udio u ukupnoj masi uzorka. Najprije se izvaga svježe uzeti uzorak i izvrši 

mjerenje senzorom, i potom se zemlja periodično suši i vaga, bilježeći izlazne vrijednosti senzora, sve 

dok ne prestane da gubi na težini. Tada je procenat sadržaja vode jednak nuli, pa se može izračunati 

prvobitna vlažnost zemljišta. 

Neka je u početku masa iznosila m1 – u kojoj je sadržana ukupna masa vode i suve zemlje, a na 

senzoru očitavamo napon V1. Za poslednje mjerenje znamo da će vaga pokazati isključivo masu 

zemlje, i neka ona iznosi m2, dok senzor pokazuje napon V2. Tada je ukupna masa vode u početku 

iznosila mv=m2-m1, pa se njen udio u procentima računa iz proporcije datoj u jednačini 6.1. 

𝑚1: 100 = 𝑚𝑣: 𝑥 

⇒ 𝑥 =
𝑚𝑣

𝑚1
∗ 100 =

𝑚1 − 𝑚2

𝑚1
∗ 100 

𝑥 = (1 −
𝑚2

𝑚1
) ∗ 100[%], 𝑚1 ≥ 𝑚2 

Jednačina 6.1: Računanje vlažnosti u toku postupka sušenja 

 

Dobijena je savršeno prosta jednačina za precizno računanje vlažnosti zemljišta, u kojoj figurišu 

početna i krajnja masa uzorka. Sada je još potrebno pronaći vezu između jednačine i dobijenih 

naponskih vrijednosti. Pošto sada znamo masu suve zemlje i napon V2 kojima odgovara 0% vlažnosti, 

potrebno je pronaći i drugu krajnju tačku za 100% vlažnosti. Po definiciji treba dodati u posudu 

količinu vode mase m2, i neka njoj odgovara napon V3. Sada možemo naći linearnu zavisnost: 

𝑉𝑙 =
𝑉3−𝑉2

100
∗ 𝑉𝑥 [%], 

Jednačina 6.2: Linearna prava koja povezuje dvije krajnje tačke 

 

Gdje Vx predstavlja izmjerenu vrijednost napona pri bilo kom mjerenju. Sada možemo iskoristiti 

mjerenja koja su izvršena tokom sušenja zemlje da bi uporedili odstupanje linearne aproksimacije od 
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tačnih vrijednosti, i, ukoliko su ona značajno velika, zavisnost napona od vlažnosti se može mapirati 

ili aproksimirati krivom većeg reda. 

Ovim je problem mjerenja vlažnosti zemljišta sveden na čitanje izlaza ADC-a, pa se izlaz senzora 

može čitati voltmetrom ili, u ovom slučaju – analogno-digitalnim pretvaračem mikrokontrolera. 

Podaci se dalje mogu čuvati radi obrade i analiziranja, što omogućava sve prednosti digitalizacije. 

Rezultati su postojani pri bilo kojoj zapremini zemlje, pa se senzor može koristiti na otvorenom – što 

je u skladu sa industrijskim potrebama. 

Vlažnost dobijena ovim putem je predstavljena u masenoj jedinici. Osim po odnosu masa, 

vlažnost zemljišta se može računati i po odnosu zapremina suve zemlje i vode – zapreminska 

jedinica. Ove dvije veličine su sljedstveno i brojno različite, i između njih možemo naći vezu koristeći 

zavisnost mase i zapremine, koja je data u jednačini 6.3. 

𝑉 =
𝑚

𝜌
 

Jednačina 6.3: Zavisnost mase, gustine i zapremine 

 

Gustina vode nam je poznata i iznosi 997kg/m3, ali je potrebno izmjeriti i gustinu datog tipa 

zemljišta. Međutim, glavni nedostatak ovog metoda u odnosu na maseni odnos je to što se ne može 

jednosmisleno odrediti zapremina zemljišta. Ona zavisi od faktora sabijenosti, što dodatno 

komplikuje mjerenje. Zato se u ovom projektu koristi maseni odnos, jer možemo tačno da izmjerimo 

masu pri kalibraciji. 

 

6.1 Rezultati kalibrisanja i aproksimativna kriva 

Za ovaj ogled je korišćen uzorak biljnog humusa koji je prethodno dobro osušen. Donja granica 

napona koja je izmjerena u vazduhu iznosi 0,2V. Gornja granica iznosi oko 2,2V i njoj odgovara 100% 

vlažnosti. Zanimljivo je da u čistoj vodi bez prisustva zemlje napon iznosi 1,87V; što znači da njegova 

vrijednost opada nakon većinskog sadržaja vode u zemljištu, što je potvrđeno eksperimentom. 

Mjerenja su vršena nakon dodavanja vode u iznosu od oko 10% početne težine uzorka, što daje 

dovoljno tačaka za aproksimaciju. Uzeta je prosječna naponska vrijednost od nekoliko uzastopnih 

mjerenja. 

Matlab posjeduje alate za osnovno izračunavanje aproksimativnih krivih, u meniju APPS > Curve 

Fitting. Potrebno je izabrati promjenjive i vrstu jednačine, a kao rezultat se dobija najpribližnija kriva 

sa zadatim parametrima, kao i neki statistički podaci. Na slikama 6.1-6.3 su dati redom grafici za: 

linearnu, kvadratnu i eksponencijalnu jednačinu sa srednjom kvadratnom greškom (SKG). Data je 

zavisnost napona od procentnog sadržaja vode. 
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Kao što je i očekivano, rezultatima mjerenja je najbliža eksponencijalna kriva sa najmanjom 

srednjom kvadratnom greškom. Ukoliko bi ona bila suviše zahtjevna za mikrokontroler, može se 

koristiti i kvadratna jednačina. 

Slika 6.1: Prava 𝑓(𝑥) = 0,5465 ∗ 𝑥 + 1,426; SKG = 0,1572 

Slika 6.2: Kvadratna jednačina 𝑓(𝑥) = −0,1364 ∗ 𝑥2 + 0,5535 ∗ 𝑥 + 1,55; SKG = 0,1052 

Slika 6.3: Eksponencijalna jednačina 𝑓(𝑥) = 1,64𝑒0,175 − 𝑒−1,5; SKG = 0,09177 
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6.2 Postupak mjerenja 
 

Iako je postignuta vrlo velika osjetljivost senzora u laboratorijskim uslovima, nepravilno izvršeno 

mjerenje može značajno da utiče na rezultat. Ovo su neki uslovi o kojima treba voditi računa: 

1. Dubina i položaj senzora 

Senzor se svaki put mora postaviti na istoj dubini, zato što ekvivalentna kapacitivnost zavisi od 

površine elektroda koje se nalaze u zemlji. Ako bi se senzor samo djelimično ubacio u zemlju, 

kapacitivnost C1 bi se sastojala od paralelne veze dvije kapacitivnosti – jedne iznad, a druge ispod 

zemlje. U tom slučaju bi bilo: C1 = C1iznad + C1ispod (slika 5.2); što bi dovelo do linearne zavisnosti 

greške mjerenja od dubine na kojoj se vrši. Kućište treba da obezbijedi gornju granicu do koje senzor 

može da se ukopa. 

Takođe treba voditi računa o položaju, tj. o uglu, u kom se postavlja senzor. Iako to manje utiče 

na rezultat, ipak nagib ne treba da bude značajno veliki zato što treba obezbijediti dovoljnu količinu 

zemlje cijelom dužinom i sa obije strane elektroda. 

2. Čišćenje senzora prije ponavljanja mjerenja 

Pošto najviše uticaja na ekvivalentnu kapacitivnost vrše slojevi zemlje koji su najbliži senzoru, 

potrebno je nakon svakog mjerenja očistiti ostatke zemlje. Ako bi, na primjer, nakon mjerenja 

vlažnosti mokre zemlje odmah ubacili senzor u suvlju zemlju bez čišćenja, to bi ostaci mokre zemlje 

ili same vode, u zavisnosti od količine, manje ili više poremetili rezultat. Čišćenje izolacionog sloja je 

lako, a najbolje je koristiti ubrus kako bi upio ostatke vlage. 

3. Sabijenost zemlje 

Pri ubacivanju senzora u zemlju, može se desiti da ona ne prijene dobro za izolacioni sloj, tj. da se 

pojavi praznina između zemlje i senzora. U tom slučaju treba blago pritisnuti zemlju okolo, tako da 

bude prirodno sabijena. Sa pritiskanjem ne treba pretjerivati, jer može da dođe do preraspodjele 

vlage, odnosno do njenog kretanja od tačaka sa većim pritiskom do onih sa manjim pritiskom 

(cijeđenje). 

4. Homogenost 

Da bi rezultati što tačnije pokazivali stvarno stanje, treba se pobrinuti da vlaga u zemlji bude 

ravnomjerno raspoređena. U suprotnom bi na različitim mjestima dobijali različite rezultate. Ovo je 

naročito važno kod postupka kalibracije sušenjem, jer se gornji slojevi zemlje suše brže od donjih, a 

rješava se jednostavnim miješanjem uzorka. 

5. Prosječna vrijednost 

Kako bi se što više umanjio uticaj promjenjivih parametara, treba izvršiti više mjerenja i naći 

prosječnu vrijednost – kao i kod mjerenja bilo koje druge veličine. 
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6. Tip zemljišta i odgovarajuća kalibracija 

Kako je već pomenuto, svaki tip zemljišta ima svoje prepoznatljive osobine pa se i kalibracija mora 

vršiti posebno. Pogrešno bi bilo za mjerenje koristiti jednu vrstu zemljišta, ako je kalibracija izvršena 

za drugu vrstu. 

7. Dubina na kojoj se mjeri 

Ovaj senzor je dizajniran za mjerenje vlažnosti površinskog sloja zemljišta do određene dubine, i 

ne može se koristiti za dublje slojeve jednostavnim ukopavanjem. Za to je potrebno uzeti uzorak sa 

željene dubine, ili iskopati širu rupu tako da se oko gornjeg dijela senzora ne nalazi zemlja u dovoljno 

velikom prečniku koji ne utiče na rezultat. 

Pošto se u industriji traži i mjerenje na različitim dubinama, sa inženjerske tačke gledišta potrebne 

izmjene nijesu zahtjevne. Kapacitivne elektrode treba smjestiti u dovoljno čvrstom izolatoru, i izvesti 

ih do odgovarajuće dužine, dok je elektronski dio gotovo isti. 

 

6.2.1 Vlažnost drugih rastresitih materijala 

Iako je ovaj senzor namjenski napravljen za vlažnost zemljišta, nema nikakve prepreke da se 

koristi i za druge materijale slične strukture (u koje je moguće ubaciti sondu). I u tom slučaju treba 

voditi računa o svemu gore navedenom. S obzirom da neki materijali sporije upijaju tečnost, treba ih 

dobro promiješati kako bi ona bila ravnomjerno raspoređena. 

 

VII Štampanje pločica UV metodom 

Mogućnost izrade sopstvenih pločica je veoma korisna i poželjna, što je naročito došlo do izražaja 

u vrijeme masovnih zatvaranja i obustavljanja dostava iz inostranstva. Postupak štampanja je 

pokrenut od nule i završen uspješno, čime je napravljena ploča za senzor sa integrisanim 

kondenzatorom. 

Od više razmatranih postupaka, odabran je UV pozitiv metod zbog preciznosti i mogućnosti 

masovne proizvodnje. Postižu se odlični rezultati, a hardverski dio procesa je gotov za desetak 

minuta. Postupak izrade je opisan u šest koraka. 

 

1. Crtanje električne šeme i putanja u softveru 

Za ovaj dio posla je korišćen besplatni softver KiCAD, a postoje i brojna druga rješenja: Altium 

Designer, EasyEda (onlajn), Fritzing, Eagle… Crtanje električne šeme (Schematic Layout Editor) je 
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gotovo isto kao i kod drugih alata, a zatim se svakoj komponenti dodjeljuju štampani otisci. KiCAD 

posjeduje ogromnu bazu otisaka, a moguće je i dizajnirati svoje za bilo koju komponentu ili uređaj. 

Nakon toga slijedi crtanje putanja (PCB Layout Editor) koje fizički predstavljaju kontakte na ploči. 

Pritiskom na dugme Update PCB from schematic, učitaju se otisci svih komponenata sa električne 

šeme. Potrebno ih je ručno rasporediti i iscrtati putanje u skladu sa šemom. Za sledeći korak je 

potrebno sačuvati SVG zapis dizajna pritiskom na File > Export > SVG. Pošto se radi o vektorskoj 

grafici, mogu se koristiti visoke rezolucije štampe.  

 

2. Štampanje na providnoj foliji ili paus papiru 

Za kvalitetni otisak je neophodno koristiti laserski štampač rezolucije bar 1200dpi. Druge vrste 

štampača ne mogu dobro da štampaju na ovim materijalima, i uglavnom imaju manju rezoluciju. Oba 

materijala dobro propuštaju UV svjetlost, za razliku od običnog papira. Za jednostranu izradu pločice 

se štampa se originalni crtež, a ne odraz u ogledalu. 

 

3. Osvjetljavanje UV lampom 

Sada se papir postavi uz ploču od pertineksa stranom na kojoj je štampano. Sve se zajedno 

pritisne uz staklo, okrenuto prema UV lampi (slika 7.1). U ovom slučaju je vrijeme osvjetljavanja 

iznosilo tri minuta, a ono zavisi od jačine osvjetljenja. 

 

Slika 7.1: Kutija sa UV lampama 
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UV svjetlost priprema izloženi lak za razvijanje. Preslikavanje nije vidljivo dok se lak ne razvije. 

Korišćene su četiri fluorescentne UV sijalice snage 15W, postavljene tako da svjetlost bude što 

ravnomjernije raspoređena. Po potrebi se koristi samo gornji ili donji par (za jednostranu 

tehnologiju), ili sve četiri (za dvostranu). 

 

4. Razvijanje laka 

Pločica od pertineksa se ubaci u rastvor NaOH (10g na 1l vode). NaOH nagriza kožu, pa se treba 

odgovarajuće zaštiti od dodirivanja i isparenja. Uz stalno miješanje rastvora, razvijanje ne treba da 

traje duže od tri minuta. Na kraju će se jasno razlikovati linije koje predstavljaju kontakte. Ako se 

ploča zadrži predugo u rastvoru, doći će do otapanja čitavog laka. 

 

5. Nagrizanje bakra 

Za uklanjanje viška bakra je najbolje koristiti ferihlorid (FeCl3). Međutim, kako se on teško nalazi, 

može da posluži i rastvor sone kisjeline (HCL) i vodonikovog peroksida (H2O2). Isto se potrebno 

zaštiti od dodirivanja hemikalije i isparenja, a nagrizanje treba obaviti na otvorenom ili u prostoriji sa 

dobrom ventilacijom. Kako bi nagrizanje bilo ravnomjerno, rastvor treba miješati tokom cijelog 

postupka. Rezultati su vidljivi ubrzo nakon potapanja ploče, a završeno je kada se odstrani sav 

nepotrebni bakar (slika 7.2). Na gornjoj slici se vidi tek započeti tok odstranjivanja bakra, a u sredini 

poodmakli gdje je ostalo još malo bakra uglavnom pri krajevima.  
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Slika 7.2: Tri faze nagrizanja bakra 

 

Na donjoj slici je prikazana gotova pločica, i tada je treba izvaditi iz rastvora jer bi se otopio i 

korisni bakar. Iako je on sa gornje strane zaštićen lakom, ivice su izložene i zbog toga bi se otapanje 

nastavilo u svim pravcima normalnim na ivice kontakata, što bi dovelo do njihovog stanjivanja i, na 

kraju, iščezavanja. Na slici 7.3 je data provjera kvaliteta sa zadovoljavajućim rezultatom. 

 

Slika 7.3: Poređenje štampane maske i gotove bakarne pločice 
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6. Lemljenje 

Kada je peti korak gotov, može se preći na lemljenje. Najprije treba odstraniti višak laka blagim 

šmirglanjem i probušiti rupice za komponente, a potom ih zalemiti sa suprotne strane kontakata. 

Izgled gotovog senzora u radnom režimu, kao i njegovo smještanje je dato na slikama 7.4 i 7.5. 

 

 

Slika 7.4: Senzor vlažnosti zemljišta u saksiji 
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Slika 7.5: Radna proba čitavog sistema 
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VIII Rezultati testiranja 
 

Testiranje predloženog sistema je izvršeno u periodu od 15/10/2020 do 24/03/2021. Ukupan broj 

kanala poslatih poruka prema ThingSpeak kanalu “IoT MECOnet”, 

https://thingspeak.com/channels/1199838, dat je u Tabeli 8.1. 

 

Poruke/kanali Broj poslatih poruka Frekvencija slanja 

Broj poruka 149661 60 sekundi 

Broj kanala 4 60 sekundi 

Tabela 8.1: Broj poslatih poruka 

 

Dnevno je slato oko 1380 poruka, što se vidi na slici 8.1. 

 

Slika8.1: Dnevni protok poruka od uređaja prema serverima ThingSpeak i www.meconet.me 

 

Postignuti rezultati u odnosu na domet uređaja su predstavljeni u tabeli 8.3. Poruku čini jedan 

neprekidni string (niz karaktera), i primjećuje se da je uspješnost prijema veća ukoliko je on manji. 

Idealno bi bilo svesti veličinu poruke na jedan bajt i ponavljati slanje više puta kako bi se ostvarila 

najveća vjerovatnoća prijema. Međutim, u ovom slučaju ne mogu svi podaci da stanu u jedan bajt. 

Dodatna mogućnost je razbijanje poruke na osmobitne cjeline, i slanje svake od njih uzastopno više 

puta. 

Veličina poruke Ostvareni domet 

9 znakova > 1,5 km 

30 znakova 200-300 m 
Tabela 8.2: Zavisnost dometa od veličine poruke 

https://thingspeak.com/channels/1199838
http://www.meconet.me/
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Parametri koje je prihvatao i obrađivao testni kanal su dati u Tabeli 8.3. 

 

Ime kanala IoT MECOnet 

Opis kanala Vlažnost i temperatura vazduha i vlažnost 

zemljišta na lokaciji MECOnet mjeri Heltec 

WiFi LoRa 32(V2) i šalje svakih 60 sekundi na 

Thing Speak. Povratna sprega i kontrolni 

signal se šalju sa Thing Speak na MECOnet 

lokaciju. 

Polje 1 (Field 1) Humidity in % 

Polje 2 (Field 2) Temperature in Cel 

Polje 3 (Field 3) Moisture in % 

Polje 4 (Field 4) Control (H-T-M) 

Polje 5 Send command (threshold) value 

Tabela 8.3: Parametri testnog kanala 

 

Fotografija objekta regulacije na lokaciji je prikazana na donjoj slici. Verifikacija je obavljena kako 

u realnom okruženju preuzeća “Plantaže”, tako i u laboratoriji Instituta MECOnet (slika 8.2). 

 

  

Slika 8.2: Detalji eksperimenta i prototip uređaja – Plantaže (lijevo) i MECOnet (desno) 
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Slike ispod prikazuju realno stanje na ThingSpeak kanalu u segmentu regulacije po gornjim 

poljima (Fields). 

 

Slika 8.3: Dijagram promjene vlažnosti vazduha u određenom vremenskom intervalu 

 

 

Slika 8.4: Dijagram promjene temperature vazduha u određenom vremenskom intervalu 
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Slika 8.5: Dijagram promjene vlažnosti zemljišta u određenom vremenskom intervalu 

 

 

Slika 8.6: Kontrolni signal paljenja-gašenja uređaja u određenom vremenskom intervalu 
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Slika 8.7: Polje za unošenje referentnih vrijednosti 

 

 

Slika 8.8: Srednja vrijednost temperature za određeni broj mjerenja 

 



Telemetrijska IoT stanica za potrebe precizne poljoprivrede Specijalistički rad 
 

40 
 

 

Slika 8.9: Uživo posmatranje dijagrama na korisničkoj web stranici 
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Na slikama 8.10 i 8.11 je prikazana serijska komunikacija između uređaja i računara. Osim 

pregleda brojnih vrijednosti, ona je korisna i za kontrolu rada koda, tj. debagovanje. Na slici 8.10 su 

dati izlazni podaci serijske komunikacije na stanici. Promjenjiva Reg sadrži kombinovanu poruku koju 

čine mjerene brojne vrijednosti, svaka u svom binarnom opsegu. Pomoću nje je moguće provjeriti da 

li su brojne vrijednosti pravilno zapisane i primljene na drugoj strani. 

Slika 8.11 sadrži nešto više podataka. Linija „Received a packet.“ označava da je primljena poruka 

od stanice.  Osim prethodno navedenih promjenjivih, nalaze se i one za: kontrolu, snagu signala 

(RSSI) i poruka u obliku stringa, tj. njen ASCII kod. Linija „Sending message: “ sadrži promjenjivu koja 

se šalje od servera ka stanici, a vezana je za kontrolu. Na primjer, u ovdje je zadata vrijednost 1:40 

koja se odnosi na prvi kanal namijenjen vlažnosti vazduha. Poruka je skraćena na „140“ radi veće 

vjerovatnoće ispravnog prijema, i poslata ka stanici. Već u narednoj poruci vidimo da je kontrolni 

broj promijenjen iz nule u jedinicu jer je vlažnost od 35% manja od zadate, a prvi kanal je 

predstavljen bitom najmanje težine u kontrolnoj promjenjivoj. 

 

 

Slika 8.10: Serijski izlaz stanice 
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Linija IoT „Handling Server Channel update successfull.“ označava uspješno postavljanje trenutnih 

vrijednosti na serveru. To je znak da sistem radi kako treba, pa treba resetovati watchdog tajmer. 

Linija „Resetting WDT...“ znači da je on resetovan. Ukoliko bi, iz nekog razloga, došlo do zastoja u 

slanju poruka na server, istekao bi watchdog tajmer i mikrokontroler bi se restartovao i krenuo sa 

radom ispočetka. Takvi zastoji se uglavnom dešavaju u zastoju u radu programa i mogu biti trajni, pa 

bi bio nepohodno ručno restartovati mikrokontroler. 

 

 

Slika 8.11: Serijski izlaz priručnog uređaja 

 

  



Telemetrijska IoT stanica za potrebe precizne poljoprivrede Specijalistički rad 
 

43 
 

Zaključak 

 
U ovom radu je napravljen sistem koji može da mjeri: temperaturu vazduha, vlažnost vazduha i 

vlažnost zemljišta. Grafici i trenutne vrijednosti se mogu posmatrati na IoT platformi ThingSpeak. 

Omogućena je dvosmjerna komunikacija na kanalu ThingSpeak radi zadavanja ciljanih vrijednosti, 

koje bi stanica postizala uključivanjem i isključivanjem odgovarajućih uređaja. 

Pored grafika za mjerene veličine, nalazi se i jedan grafik namijenjen kontroli od strane korisnika. 

On sadrži informacije o tome koji su uređaji trenutno aktivni. Kontrolne (željene) vrijednosti se 

zadaju na kanalu ThingSpeak, a povratnu informaciju šalje stanica nakon preduzimanja potrebnih 

radnji. Ovdje se radi demonstracije kontroliše rad LED dioda – po jedne za svaku veličinu, od kojih je 

obrazovan binarni broj. 

Iskorišćene su prednosti savremene tehnologije, koje podrazumijevaju upotrebu solarne energije 

i interneta. Opisan je i postupak izrade štampanih pločica UV metodom, koji je korišćen za pravljenje 

kapacitivnog senzora. 

Sistem je pogodan za naučna istraživanja i koristan je poljoprivrednim proizvođačima koji žele da 

primijene savremenu tehnologiju u svom radu. Može se koristiti i kao gradivni blok za složenije 

sisteme, koji bi pokrivali i kontrolisali veće zasade, što odgovara industrijskim potrebama. 

Iako su korišćeni senzori koji su od značaja u poljoprivredi, stanica se može opremiti i drugim 

vrstama senzora koji odgovaraju drugim djelatnim oblastima. 

Navedeni domet za komunikaciju između mikrokontrolera iznosi 5km, međutim, to predstavlja 

idealni slučaj: kada su vremenske prilike najpovoljnije, nema elektromagnetnih i fizičkih smetnji i 

predajnik se nalazi na visini iznad prijemnika. Kako se ovdje radi o dvosmjernoj komunikaciji, najbolje 

je da uređaji budu na otprilike istoj visini. Domet značajno zavisi i od dužine poslate poruke: što je 

poruka duža – veća je i vjerovatnoća da dođe do greške. Rješenje za to je slanje što kraće poruke više 

puta uzastopno uz korišćenje tehnika binarne provjere (npr. parnost ili kontrolni bitovi). Time se 

znatno povećava vjerovatnoća ispravnog prijema bar jedne poruke pri slabijem signalu (na većoj 

razdaljini). U projektu je postignuta komunikacija na daljini od preko jednog kilometra. 

Neke mogućnosti daljeg usavršavanja su: 

• Povećanje dometa signala za komunikaciju između mikrokontrolera, što je moguće 

ugradnjom jače antene. 

• Dodavanje većeg broja senzora, kao npr: brzina i smjer vjetra, količina padavina, jačina 

UV svjetlosti i drugih. 

• Realizacija složenijeg pregleda grafika, tako da se na zahtjev može pogledati duža istorija 

tokom mjeseci i godina, upoređujući mjerene veličine. 

• Računanje statistike i parametara koji su bitni za rast, sazrijevanje i zdravlje biljke, kao i 

razvoj štetočina. Ovo se može sprovesti na jednom od mikrokontrolera ili na samom 

serveru. 
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